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Norfolk Air Photo Library (NAPL) 
 

 

The Norfolk Air Photo Library contains over 85,000 images 
of Norfolk and consists of oblique photographs, vertical 
photographs, and special collections.  
 
 The collection is housed at the offices of the Historic 

Environment Service in Gressenhall and can be viewed by 
appointment (please see the Access page for further 
details).  

 
 All images within the collection are available for 

consultation on-site and digital copies of NCC copyright 
images can be requested for personal use or publication. 
  

 The images are filed by 1km areas based on the National Grid Co-ordinates for the centre of the 
image. You will need to provide the HER Officer with the National Grid Co-ordinates for the 
geographical area you would like to look at or provide a good plan of the region. 

 
 

1. Oblique Image Collection 
 

Oblique images are taken at an angle, often using a hand-held camera from an open window. They 
tend to focus on a specific building or site and the angle at which they’re taken tends to highlight 
details such as earthworks in the landscape.  
 
The core of our oblique image collection is formed of over 40,000 specialist photographs of 
archaeological sites and historic buildings in Norfolk taken by Derek A. Edwards between 1974 and 
2000. These images focus on cropmarks, earthworks, and historic buildings throughout the county and 
provide an important record of Norfolk’s heritage.  
 
The Oblique Image Collection also includes copy prints of Norfolk images held by other repositories, 
including the Cambridge University Centre for Air Photography (CUCAP) and the National Monuments 
Record (NMR), as well as images taken by private individuals and organisations, including Aerial 
Archaeology Foundation and Mike Page (freelance aerial photographer). 
 

2. Vertical Image Collections 
 
Vertical images are taken with a mounted camera with the lens pointing straight down. Photographs 
are usually taken at specific intervals as the plane flies in parallel lines over a given area in order to 
capture a map or plan of that area at a specific scale. The NAPL contains three primary collections of 
vertical images. 
 
RAF Images (1946) 
This collection consists of over 8,000 vertical photographs of Norfolk taken by the RAF as part of the 
National Air Survey of 1946. The photographs were taken at a scale of approximately 1:10,560 or six-
inches to one-mile and overlap to provide stereoscopic viewing. The collection provides almost 
complete coverage of the county and selected images were used to form the digital map available for 
consultation on the Norfolk Historic Maps website http://www.historic-maps.norfolk.gov.uk. 

Thetford Castle (NHER 5747) 

http://www.historic-maps.norfolk.gov.uk/
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Ordnance Survey Images 
The NAPL contains copy prints of approximately 11,000 vertical photographs taken by the Ordnance 
Survey between 1964 and 1997 for mapping purposes. This collection does not provide complete 
coverage of the county. Additional Ordnance Survey images are held by the National Monuments 
Record in Swindon. 

 
1988 Aerial Survey 
This aerial survey was commissioned by Norfolk County Council and was carried out by BKS Surveys 
Ltd in the summer of 1988. It provides overlapping colour images of the entirety of the county at a 
scale of 1:10,000 which overlap to allow for stereoscopic viewing. These images were used to form 
the digital map available for consultation on the Norfolk Historic Maps website http://www.historic-
maps.norfolk.gov.uk. 

 

3. Special Collections 
 

The ‘Floodlight’ Project (1953) 
This collection consists of over 2,000 vertical and oblique photographs taken by the RAF during and 
after the coastal floods of February 1953. These images provide coverage of the Norfolk coast and 
some low-lying areas further inland.  

 
Royal Flying Corps Collection (1915-1917)  
The Royal Flying Corps (RFC) was founded in April 1914 and continued until 1918, when it became the 
principal element of the RAF. In its early years, the corps was primarily used for reconnaissance and 
its members were instrumental in developing the first practical aerial cameras. The NAPL holds a small 
collection of copy prints of images taken by members of the RFC, which were donated by several 
private individuals. The collection includes a mixture of aerial photographs of the county and images 
of members of the RFC. 
 
H. Frederick Low Collection 
H. Frederick Low was the official photographer of the Norfolk and Norwich Aero Club, which was 
formed at Mousehold Heath Aerodrome in 1927. The NAPL holds a small collection of copy prints of 
a variety of images taken by H. Frederick Low, including aircraft flown by the Aero Club and aerial 
images of selected archaeological sites in Norfolk.  
  
George Swain Collection (1920-1958) 
The George Swain photo archive is a large collection of glass plate and celluloid negatives and prints 
of Norfolk taken by Norwich photographers George Edwin Swain (1869-1933) and George Swain junior 
between c. 1880 and 1965.  
 
The bulk of this collection is comprised of internal and external photography of buildings in Norwich, 
cityscapes, portraits, and images taken by George Swain as an official wartime photographer. These 
images are held in the Norfolk Heritage Centre, operated by the Norfolk Library and Information 
Service (NLIS).  
 
However, George Swain junior was also a pioneer in aerial photography and the collection includes 
approximately 1100 aerial photographs taken between 1920 and 1958. Copy prints of these images 
are held within the Norfolk Air Photography Library. 
 

http://www.historic-maps.norfolk.gov.uk/
http://www.historic-maps.norfolk.gov.uk/
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How do I Access NHES Resources? 
 
The Norfolk Historic Environment Record and associated archives are based at the Gressenhall Farm and 
Workhouse Museum in Gressenhall, near Dereham.  

YOU CAN …  

 

OR 

 
 
 
 
 

NHES RESOURCES INCLUDE: 

 Norfolk Historic Environment Record 

 Digital Database 

 Secondary Files 

 The Norfolk Aerial Photograph Library 

 NHES Reference Library 

 

CONTACT DETAILS: 

Post:   Norfolk Historic Environment Record 
Union House 
Gressenhall, Dereham, Norfolk 
NR20 4DR 

Phone: 01362 869 282 

E-mail: heritage@norfolk.gov.uk 

OPENING TIMES: 

The NHER is open for enquiries Monday to Friday, 10am to 4pm.  

Appointments can normally be booked for Tuesdays and Thursdays between 10am and 4pm. 

If you wish to visit in person you will need to telephone or e-mail first to make an appointment and 
make sure that someone is available. An appointment can normally be arranged within 5 working 
days.  

 
FACILITIES 

If you choose to visit the NHER in person we have a work space with a computer terminal available 
for you to use. The HER Officer will assist you and make you familiar with the database, if you choose 
to use it, and digital data can be saved on a portable drive. 

The HER Officer will retrieve relevant items from our archives in advance of the appointment and 
will assist with making photocopies and scans where possible. Charges may apply for obtaining 
digital copies. 
 

CHARGES 

The Norfolk Historic Environment Service has a policy of charging developers and their agents, 
consultants and contractors to consult the Historic Environment Record for commercial purposes or 
to reproduce images or digital data. Please see our Charges information sheet for full details. 

If you are consulting the HER for any other purpose, please contact us to obtain an exemption form 
as some charges may be waived. The majority of our services are offered free of charge to 
individuals accessing our data for non-commercial purposes.  

 View the NHER records on-line via the Norfolk Heritage Explorer 
www.heritage.norfolk.gov.uk 

 

 Contact us by letter, email or telephone to:  

 discuss a query with a member of staff 

 request a bespoke search 

 make an appointment to visit us in person 
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Other sources of maps 
 
Historic Maps of Norfolk 
 
Historic Maps of Norfolk is a website dedicated to historic maps and aerial photographs 
showing Norfolk. It features an interactive map explorer which enables you to view 
historical maps alongside historical aerial survey data and modern day Ordnance Survey 
maps. Overlay maps to pinpoint changes in the geographic landscape of the County. There is 
also a map image viewer which allows you to look at some of the historical maps of the 
Norfolk area held in the Archive Centre at County Hall including those of Norwich, Great 
Yarmouth, Thetford and Kings Lynn.  
 
It can be found at: http://historic-maps.norfolk.gov.uk/  

 
Norfolk Record Office 

 
The Norfolk Record Office is an archive of historical documents based at County Hall in 
Norwich. The archive contains millions of documents, which are available for public 
consultation on weekdays. They range in date from the eleventh century to the twenty-first 
and relate to every town and parish in Norfolk. Among them are royal charters, title deeds, 
manorial court rolls, registers, accounts, minute books, correspondence, diaries, maps, 
architectural and other drawings, photographs, music and oral histories.  
 
NRO staff are available to help with locating documents in person, or by telephone, post and 
email. There are also several handy research guides on the main website. Part of the archive 
can be found online at: http://nrocat.norfolk.gov.uk  
You will need a reader’s ticket to access the search room, NRO will request that you bring 
some identification. 
www.archives.norfolk.gov.uk/ 
Norfolk Record Office 
The Archive Centre 
Martineau Lane 
Norwich 
NR1 2DQ 

Telephone: 01603 222599 

E-mail: norfrec@norfolk.gov.uk 
 
  

http://historic-maps.norfolk.gov.uk/
http://nrocat.norfolk.gov.uk/
http://www.archives.norfolk.gov.uk/
mailto:norfrec@norfolk.gov.uk
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Old Maps 

 
Old Maps Online is a fantastic website for finding historic maps. The portal allows you to see 
digital copies of maps from archive and library collections all over the world. You can either 
browse an area using a modern OS map for reference, or search for a specific place name, 
some of the collections date back to the 15th century, with most starting in the 16th century.   
The map viewer can be accessed at www.oldmapsonline.org  
 

National Archives 

 
The National Archives is the official archive and publisher for the UK government, and for 
England and Wales. The National Archives' collection of over 11 million historical 
government and public records is one of the largest in the world. From Domesday Book to 
modern government papers and digital files, the collection includes paper and parchment, 
electronic records and websites, photographs, posters, maps, drawings and paintings. 
 
Many documents are available to consult online, if you wish to see original documents you 
will need to register for a reader’s ticket, please note the National Archive request that you 
bring two forms of identification with you. 
www.nationalarchives.gov.uk/ 
The National Archives  
Kew, Richmond  
Surrey TW9 4DU 
020 8876 3444 
 
 

British Library 

 
The British Library is the national library of the United Kingdom. The collection includes 
more than 150 million items, in over 400 languages, to which three million new items are 
added every year. It contains books, magazines, manuscripts, maps, music scores, 
newspapers, patents, databases, philatelic items, prints and drawings and sound recordings. 
There is a catalogue and a variety of research guides in the ‘help for researchers’ section of 
the website. To register for a reader’s ticket you will need identification, and to have found 
the documents that you are interested in through the catalogue. 
 
www.bl.uk  
The British Library 
96 Euston Road 
London 
NW1 2DB 
0330 333 1144 

 

http://www.oldmapsonline.org/
http://www.nationalarchives.gov.uk/
http://www.bl.uk/
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Stereo Viewing 

 
Vertical photographs are usually taken from an aeroplane, with a fixed camera, that flies at a 
constant height and speed so that the prints have a nominally constant scale. The camera 
automatically takes a series or run of photographs with a set time interval between each 
photograph. This time interval is calculated so that the consecutive frames overlap by 60%.  
The plane flies back and forth along a set route so that the runs overlap by 25%.  If vertical 
photographs are taken in this way a three dimensional image of the photographs can be 
viewed using a stereoscope.  The stereoscope allows our eyes to merge the images visible on 
two consecutive prints, or stereo pairs, into one three dimensional image. 
 
 
o The photographs should be arranged by frame number for viewing in stereo.  The 

increasing frame number reflects the direction in which the camera is flying, e.g. Frame 
1 was taken before Frame 2.  Place the photographs in front of you with the two prints 
arranged in frame order from left to right.   

 
o Choose a prominent feature that you can see clearly on both frames, ideally a feature 

that is to the right hand side of Frame 1 and near the centre of the second frame.   
 
o Place the left hand print over the right hand print.  The prints should overlap enough so 

that when the stereoscope is placed on top, the left lens is over the feature you have 
chosen on the left hand photograph and the right lens is over the same feature visible 
on the right hand photograph. 

 
o If you look through the stereoscope now you will probably see two images of the feature 

adjacent to each other.  Try to make the images merge by gently moving the left hand 
photograph from side to side, whilst still looking through the stereoscope and keeping 
the right hand image still – there’s a bit of a knack to this so take your time.  Once you 
get the images into stereo you should see one image of the feature you have chosen and 
it should be in 3D.  If you are not sure whether you are viewing the images in stereo, you 
probably are not! 

 
o Once you are happy that you can see the image in stereo, try to keep the photos still and 

move the stereoscope up and down to view different parts of the image. 
 
o You can also overlap the photographs in the other direction, with Frame 2 over Frame 1, 

to see different parts of the image. 
 
o When you are looking at the prints through the stereoscope sometimes the feature that 

you want to look at is covered by the top photograph.  To see more of the image in 
stereo you will have to gently curl back the top photograph. 
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Using Google Earth for Archaeological Air Photo 
Interpretation 

 
Google Earth provides access to a range of aerial imagery across the world. Consultation of 
this imagery is now a standard part of most air photo interpretation projects. 
 
Google Earth is free and can be downloaded and installed from 
https://www.google.co.uk/earth/. When you open it, you should see a screen similar to the 
one below: 
 

 

 

 Under the 'View' pull-down menu (along the bar at the top), ensure that 'Toolbar' 
and 'Sidebar' are both ticked.  

 Enter the location you want to look at in the 'Fly To' box towards the top left-hand 
corner of the screen and click on 'Search' (the magnifying glass). 

 

 On the toolbar (visible along the top), click on the 'Show historical imagery' button. 
This will bring up a slide bar that allows you to move through images of different 
dates; what is visible will be dependent on your location and how far you have 
zoomed in. 

 
 

 
 
 

'Show historical imagery' button 

Historical imagery slider 

 

https://www.google.co.uk/earth/
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 Hovering the cursor over the historical imagery slider will show you the range of 
imagery available for that location and height. The date of the image will also be 
shown at the bottom left-hand corner of the screen. However, be wary of the dates 
assigned to the images, as they are not necessarily correct; for example, 
photographs clearly taken in the summer months may be shown with a date in 
January or December. 

 The copyright holder will be shown centrally at the bottom of the screen. Although 
we are not aware of any restrictions on the use of Google Earth for non-commercial 
purposes, it is always advisable to credit the source and copyright holder when using 
photographic images. 

 Under the 'File' pull-down menu, select 'Save', then 'Save image'. This allows you to 
save a jpeg of the image on the screen. This can then be used in other programmes 
to digitally trace or map the features. 

 Google Earth images don't usually need to be rectified. However, depending on what 
method you are using to map features, you may need to locate and re-scale them in 
relation a base map. 

 As with all aerial photographic survey and interpretation, make sure you make a 
note of the date of any Google Earth layers you have used to map or record 
archaeological features, and include this in records and reports. 

 

Practical exercises: 
 

 Looking for sites: Use the 'Fly To' box to look at the images for a location you are 
interested in. Some suggestions are: 

 
o Godwick – pan slightly southwest; the earthworks of the deserted medieval 

settlement can be seen surrounding the ruined church. They are particularly 
clear on the 1999 layer; compare their appearance in 2004 (why do they look 
different?). 

 
o Swafield – select the 2006 layer and pan north; part of a double-ditched 

enclosure with an entrance on its east side can be seen close to the church; 
pan around the area for more, often very clear cropmarks, typical of the light 
loamy soils of northeast Norfolk; compare the layers for other years. 

 
 
o Grimes Graves – compare how the earthworks of the flint mines appear in 

different years; to the northwest, the stripes of 'patterned ground' (a 
geological pattern typical of the Brecks) can be seen very clearly, particularly 
in 2003 and 2005; also to the northwest, craters, pits and tracks relating to 
Second World War military activity can be seen on the 1945 layer. 
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 Mapping sites: Navigate Google Earth to an archaeological site for feature. 

o It is a good idea to zoom in or out so that enough of the surrounding 
landscape (e.g. field boundaries, buildings, road junctions) is visible to allow it 
to be related to an Ordnance Survey map. 

o Click on 'File' > 'Save' > 'Save image' and save the image to 
BrecksFromAboveDaySchool_GoogleEarth 

o Open Paint.net and open the saved image. 
 

 
 

o Use the Pencil and Paintbrush tools to trace over or around the archaeological 
features. Different tools, brush thicknesses, etc., will produce different effects. You 
could use different colours or fill colours to denote different types of feature: 
differentiating between bank, ditch, structure, etc., or archaeological / geological / 
agricultural, or Roman / medieval / modern, for example. 

 

 
 

o Save the image again. It is a good idea to save it with a different filename. 
o This process can be duplicated with a wide variety of other basic graphics or 

photo editing software, many of which can be downloaded for free, or come 
pre-installed on computers. 

 

file:///C:/Users/dmgts/Documents/BrecksFromAboveDaySchool_GoogleEarth
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Rectification of air photographs 
 
Aerial photographs, both vertical and oblique, contain inherent distortions due to tilt (the 
angle of the camera in relation to the ground surface) and height (features being displaced 
the further they are from the 'nadir' point directly below the camera). This means that 
features on the photograph are also distorted: features nearer the camera are at a larger 
scale than those further away, parallel lines appear to converge, and shapes are distorted.  
 
To create an accurate map of archaeological features from aerial photographs, it is 
necessary to 'rectify' them. This process compensates for the distortions, and effectively 
turns them into a map. Rectification is particularly necessary to enable accurate mapping 
from oblique aerial photographs, where the tilt distortion is greater than in vertical 
photography, but vertical photographs also require rectification, particularly when the 
features to be mapped are located towards the edge of the photograph, where height 
displacement is greatest. Digital sources, such as Google Earth and LiDAR, do not usually 
need to be rectified. 
 
Most rectification is now done using computer programs. The Norfolk Air Photo 
Interpretation Team use a program called Aerial, but similar principles are used by a more 
freely available program called Air Photo. The latter is part of the Bonn Archaeological 
Software Package and can be downloaded for free from http://www.uni-koeln.de/~al001/. 
The current version is AirPhotoSE, and includes a detailed Help manual. 
 
There are also manual methods of transcription, but these are generally less accurate than 
computer methods. The most common methods of manual transcription are the 'network' 
method and 'paper strip' method. Details of these are given in Wilson (2000) Air Photo 
Interpretation for Archaeologists, and Connolly Beginners Guide to Aerial Survey and 
Rectification. 
 
All methods of rectification require at least four, and preferably six or more (depending on 
which method you’re using), features on the photograph that correspond to features on the 
map you want to rectify the photo to; the 'map' can be a digital source that is already 
rectified, such as a digital photo layer or LiDAR, for example. In computer methods, control 
points are assigned to corresponding locations on the photo and map, and the program 
then transforms the original image to fit the map. In manual rectification, lines are drawn 
between corresponding points on the photo and the map. The network of lines then 
provides a guide, enabling archaeological features to be drawn on the map in something 
close to their ground position. NB. Never draw on the original photograph as this damages 
the photo and may obscure the archaeological features; use a copy of the photo, or a 
transparent overlay secured on top of the photo. 
  

http://www.uni-koeln.de/~al001/
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Practical exercises: 
 

Using AirPhoto  
 

o Open AirPhoto on your computer. 
o Click the open button in the menu bar to open a map file in the 'Map image' 

window. Repeat this process with the accompanying photo.The photo and 
map can be viewed side by side. 

o Zoom and pan to the area of the photo on the map using the red box. You 
can pan around more easily by holding down the right mouse button and 
dragging. 

o Decide which points you are going to use for control. Remember to try to 
surround the area you are mapping. 

o Click in the 'Original image' and click control on the menu bar. Click 
‘Enter/Delete Point’. 

o Move the cursor over your chosen control point and click. 
o Repeat this on the base map. 
o Repeat for further control points. In AirPhoto, it is usually advisable to use a 

minimum of four control points, evenly spread across the area. 
o To zoom to a new control point right click on the image, move the red box to 

the desired point then left click. You can now set your control point. 
o If you need to delete a control point, hover over the point with your mouse. 

Once you can see it in the crosshairs, left click to delete. 
o Once you have selected at least four points, click the window bar at the top 

of the photo window to select it (it will go darker blue).  

o Press the camera with blue lense button.  
o The rectified image should now be visible with the map overlaid on top. Does 

it look correct? Where are the errors? 
o You could now close the rectified image to go back and amend some of the 

control points, or you could save the tif file for mapping. 
 
Manual transcription using the 'network' method:  

 
o Choose an aerial photo. This 

should be covered with 
drawing film or an overhead 
film. 

o Get a corresponding map 
extract. You will also need a 
sharp 4H pencil, eraser, ruler 
and, if using an overhead 
film, a fine marker pen. 
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o Look at the photo and identify 
some control points that correspond 
to features on the map. 
o Use the ruler to draw a line 
between two of the points on the 
photo and then on the map. Repeat to 
create a network of points across the 
area you want to map. You can use 
the junctions of lines as new control 
points, to enhance the network. 
 

 

o Once you are happy that 

the features to be drawn 

are sufficiently well-

located by the network to 

be accurately mapped, 

start to sketch the 

features onto the map, 

using the network of lines 

as guidance. 

o If you have more than 
one photo, the same 
network can be used, just 
re-draw it on the new 
photo. 

 
 

  



15 
 

Using Airborne Lidar Data for Archaeology 
 
Lidar is a survey method that uses pulses of laser to build up a 3-dimensional picture of the 
ground surface. This can include archaeological features when there is some sort of above-
ground expression, typically surviving earthworks or structures, even when they are very 
low. Each laser pulse can produce several 'returns', for example from both the top of a tree 
canopy and from the ground below. This means that unlike conventional aerial 
photography, 'last return' lidar data can penetrate tree cover and show archaeological 
features surviving underneath.  
 
However, it must be understood that lidar data is a 'representation' of the ground surface, 
not a perfect model, and processing the data and creating visualisations can introduce 
'artefacts', 'smooth' features, or remove them entirely. A degree of caution is necessary, 
therefore, in interpreting what is visible, and checking of features on the ground is advisable 
wherever possible. 
 

Environment Agency Lidar  
 
In England, the Environment Agency is the main holder of lidar data. Most of England has 
coverage, often from several years and at several resolutions. It can be accessed in two 
ways: 

 Downloading Environment Agency data:  
o Go to the Survey Open Data website 

http://environment.data.gov.uk/index.html. 
o Click on 'Survey Data'. 
o On the map, navigate to the location you are interested in and click. 
o A list of available data will appear at the bottom of the screen.  

 

 
 

o In general, we have found the DTM (Digital Terrain Model) datasets more 
useful for archaeological survey than the DSMs (Digital Surface Models). This 
is particularly the case in wooded landscapes or heathland, as in DTMs 
vegetation covering the ground is stripped out. This does, however, have a 
'smoothing' effect on the data, and DSMs can be useful or even preferable in 
open landscapes.  

http://environment.data.gov.uk/index.html
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o The Environment Agency's composite datasets are made up of the highest 
resolution data for each area (i.e. the 1m data will be of 1m resolution or 
higher), and these are the ones we generally use; however, clicking on the 
cross symbol next to the 'LIDAR Tiles' datasets will allow you to download 
datasets from a specific year. 

o Sliding the 'On / Off' switch next to each dataset will show the coverage. 
o To download your selected dataset, click on the green arrow to the far right. 

The datasets are quite large, and will download as a zip (compressed) file; to 
extract the files, select the downloaded folder in Windows Explorer (it will be 
called something similar to 'LIDAR-DTM-1M-TL88'), right click and select 
'Extract All …'. 

o The files will be extracted to a new, unzipped folder with the same name. In 
the folder there will be a series of files, each named with a four-figure grid 
reference (the southwest corner of the tile), a description of the type of data 
(DTM or DSM) and its resolution, and a .asc file extension, e.g. 
'tl8287_DTM_1m.asc'. As there are gaps in coverage, don't be surprised if 
tiles are 'missing'; coverage of 2m resolution data is more complete than that 
for higher resolution data. 
 

 Using Relief Visualization Toolbox:  
o The downloaded Environment Agency data consists of ASCII gridded data, 

which requires specialist software to view and manipulate. We use Relief 
Visualization Toolbox (RVT), which can be downloaded for free from 
http://iaps.zrc-sazu.si/en/rvt#v. 

o In RVT, you need to first convert the ASCII data into a geotiff. Add the 
relevant file using the 'Add file(s)' button, and then click on 'Convert' in the 
'Converter' tab. 

 

 
 

http://iaps.zrc-sazu.si/en/rvt#v
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o RVT can then produce up to nine different visualisations from the geotiff, 
including some of those most commonly used for archaeological surveys 
using lidar. Add the newly created tiff file by clicking on the 'Add file(s)' 
button, and then select which visualisations you want on the 'Visualization' 
tab. The parameters for each visualisation can be adjusted; see the RVT 
manual for lots of useful, if occasionally rather technical, information about 
the different visualisations and what effect changing the parameters will 
have. In general, the default parameters are about right for archaeological 
purposes. NB. There is a known fault with the software, which is that it 
often crashes when producing the 'PCA of hillshading' visualisation, so be 
wary about selecting this option. 

o When you are happy with your selections and parameters, click on 'Start'. 
 

 
 

o The toolbox will create a tiff file for each visualisation, in some cases with an 
8 bit version as well. These can be opened like any other image file; for 
mapping purposes, they do not need any rectification. 

 

 Using Environment Agency jpegs:  
o Alternatively, jpegs of the Environment Agency data are available on Flickr 

https://www.flickr.com/photos/environmentagencyopensurveydata/albums. 
However, jpegs contain less information than the original data; judicious use 
of photo editing software, for example, may allow archaeological features to 
be seen and mapped more easily. Crutchley and Small 2016 (full reference 
below) contains further information on this topic. 

 

  

https://www.flickr.com/photos/environmentagencyopensurveydata/albums
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Breaking New Ground lidar:  
 

 As part of the Breaking New Ground Landscape Partnership Scheme, supported by 
the Heritage Lottery Fund, the Forestry Commission and Forest Research led a 
project to survey upwards of 150 sq km of Thetford Forest and Kings Forest in the 
Brecks. More information can be found on the Breaking New Ground website 
http://www.breakingnewground.org.uk/news/revealing-the-hidden-landscape-of-
the-brecks/ 

 The air photo interpretation team are using this new data, alongside conventional 
aerial photographs, as part of their 'Brecks from Above' survey. 

 Volunteers for Breaking New Ground projects can request jpegs of the data for 
specific areas from the BNG team or via your project co-ordinator. If you are 
interested in volunteering for the 'Discovering the Archaeological Landscape of the 
Brecks' project, please contact Claire Bradshaw (claire.bradshaw@norfolk.gov.uk; 
tel: 01362 869296; see http://www.breakingnewground.org.uk/our-projects/a-
future-for-all/discovering-the-archaeological-landscape-of-the-brecks-training-
programme/). 

 It is hoped that the Breaking New Ground lidar will eventually be made available via 
the Norfolk and Suffolk Historic Environment Records. 

 

Copyright, acknowledgements and referencing 
 

 As with aerial photographs, it is important to ensure that any lidar data you use is 
properly referenced and acknowledged, with copyright statements if necessary. 

 For any survey using lidar, make a note of the source of your lidar data (Environment 
Agency or Forestry Commission, for example), the type of data (DTM, DSM), its 
resolution (1m, 2m, etc.) and, where known, the date it was flown. 

 The source of the original data should be acknowledged in any reports or the 
captions for any images. Whoever flew and/or paid for the data to be created is 
effectively the owner of that data, and can therefore limit or control its use. 

 Any visualisations produced from the data, which 'add value' to the original data, 
belong to the creator of the visualisation, so they too should be credited. 

 The creators of RVT request that you cite the following references when using 
visualisations created with their toolbox: 

o Kokalj, Žiga, Klemen Zakšek and Krištof Oštir, 2011. 'Application of sky-view 
factor for the visualization of historic landscape features in lidar-derived relief 
models, Antiquity 85 (327), 263–273. 

o Zakšek, Klemen, Krištof Oštir and Žiga Kokalj, 2011. 'Sky-view factor as a relief 
visualization technique, Remote Sensing 3, 398–415. 

 

 
  

http://www.breakingnewground.org.uk/news/revealing-the-hidden-landscape-of-the-brecks/
http://www.breakingnewground.org.uk/news/revealing-the-hidden-landscape-of-the-brecks/
mailto:claire.bradshaw@norfolk.gov.uk
http://www.breakingnewground.org.uk/our-projects/a-future-for-all/discovering-the-archaeological-landscape-of-the-brecks-training-programme/
http://www.breakingnewground.org.uk/our-projects/a-future-for-all/discovering-the-archaeological-landscape-of-the-brecks-training-programme/
http://www.breakingnewground.org.uk/our-projects/a-future-for-all/discovering-the-archaeological-landscape-of-the-brecks-training-programme/
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Practical exercises: 
 

 Using RVT: Open on the computer. 
o Using the instructions above, convert one of the Environment Agency ASCII 

files to a geotiff. Tile TL8189 is of Grimes Graves; TL8287 covers the moated 
site and deserted medieval settlement at Santon. 

o Open the geotiff in the 'Visualizations' screen, and select 'Hillshading from 
multiple directions', 'Openness – Positive' and 'Openness – Negative'. 

o Click 'Start'. The visualisations should automatically save into the same folder. 
 

 Comparing Visualisation:  
o In Windows Explorer, look at the range of files created during the previous 

task and double-click on a file to open it (use the 8-bit versions of the 
Openness visualisations). Compare what is visible on each of the 
visualisations, and how they differ from each other. Compare the lidar with 
the Google Earth extract for each area. 

o TL8189 – Grimes Graves: can you spot Grimshoe mound (a possible Bronze 
Age barrow and meeting place for the Saxon hundred court); hint: its 
appearance in the visualisations is the opposite of the mine shafts. 

o TL8287 – Santon moated site and settlement: find the moat. Compare the 
different visualisations – which one would you choose for mapping? Look at 
the area around the moated site, particularly in the forested area to the 
north; compare it to what is visible on the Google Earth extract. What 
features might be archaeology? Which would you choose to map?  

 


